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1 Objectives

At the end of this lab session, you are expected to be able to:

• differentiate between an offset (typically a dark current) and a noise;

• measure a noise amplitude, i.e. to be able to:

– use an electrical spectrum analyzer;

– convert quantities expressed in dBm@1Hz and in W/Hz,

– explain how the Spectrum Analyzer (SA) performs a measurement;

1
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– determine the influence of important parameters in any noise mea-
surement, and in particular, the influence of the bandwidth (ENBW);

– evaluate the uncertainty of the measurement;

• break down the different contributions (amplification noise, thermal noise,
photon noise) to the total noise;

• propose a measurement method for each kind of noise;

• verify if a detection system is limited by photon noise;

• justify the term “photon noise”.

The objective of the first three parts of this lab is to study the main sources
of noise present in any optical sensing system: the amplification noise, the
thermal noise, and especially the photon noise.

The photon noise is related to the quantum nature of light. It has long
been considered as a fundamental limitation. Under certain very particular
conditions , it is nevertheless possible to fall below the photon noise limit, also
known as the “standard quantum limit”, as has been demonstrated for the first
time in 1985 1. The last part presents an experiment that reduces the photon
noise to a value below the standard quantum limit.

You are asked to fill up a table during the lab in order to record your mea-
surements and verify their validity.

2 Measuring noise

2.1 Statistical approach

A noise is a random process. When measuring a noise, we want to determine
its statistical properties, in particular its variance, also known as its rms value.
By definition :

V 2
rms =

∫
v2p(v)dv

where p(v) is the density of probability of the process. It is not always
known, but it can be estimated, experimentally measured.

1Slusher et al., Phys. Rev. Lett. 55, 2409 (1985).
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2.2 Time-domain measurement

For all stationary and ergodic stochastic signals, we consider that the temporal
statistical properties are the same as the ensemble statistical properties. This is
the case for all kind of noise we will study here.

Therefore, with an oscilloscope, one can measure the Root Mean Square
voltage Vrms of v(t) (mean value is zero) defined by:

V 2
rms = lim

T 7−→+∞

1

T

∫
[T ]

v2(t)dt

This is the definition of the total power of a signal. This is also the temporal
standard deviation for a noise:

V 2
rms = σ2

v =
〈
v2(t)

〉
∀t

2.3 Frequency-domain measurement

The same RMS voltage measurement can be done in the frequency domain.
With a spectrum analyzer (SA), we can measure the Power Spectral Density
(PSD) of an electric signal. The PSD is defined by:

PSD(f) =
1

RSA
lim

T 7→+∞

2

T

〈
|ṽT (f)|2

〉
(1.1)

for frequencies f > 0. vT is the signal v(t), limited to the interval [0 T ], ṽT (f)
is its Fourier Transform. RSA is the input resistance of the SA. The PSD is
expressed in W/Hz .

The rms noise voltage, normalized at 1 Hz, vn (n for noise), is:

vn (f) =
√
RSA ·PSD (f) in V/

√
Hz .

We get the total power, so the RMS voltage by integrating the PSD over all
frequencies :

V 2
eff = RSA

∫ +∞

0

DSP(f)df =

∫ +∞

0

v2
n (f) df

2.4 Link between the autocorrelation function of a noise and
the PSD

Thanks to the Parseval theorem, we know that the total power of a signal does
not depend on the representation (time or frequency) of the signal. There is a
connection between those two, given by the Wiener-Khintchine theorem. The
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PSD can be obtained from the autocorrelation function cv (τ) = 〈v(t)v(t− τ)〉
by a Fourier Transform :

2

RSA
cv (τ)

FT→ PSD(f)

And for τ = 0, thus leads to:

V 2
eff = σ2

v = cv (0) = RSA

∫ +∞

0

DSP(f)df

2.5 White noise. Filtering.

The noises studied in this lab are very chaotic signals. There is no correlation
between their value at time t and at time t+ τ . Their autocorrelation function,
cv (τ), is zero for all the values of τ except 0: cv (τ) = 0 except in τ = 0. The
PSD is then constant for all frequencies. By analogy with optics, the expression
of "white noise" is used to characterize them. A white noise is a mathematical
model. Its variance is infinite. We usually talk about white noise in a given
bandwidth if the PSD is constant in this frequency bandwidth.

Furthermore, the measurement of a noise is always limited by a given band-
width which can be the scope bandwidth, the resolution bandwidth of the spec-
trum analyzer, the bandwidth of a filter, .... The measured rms voltage is then
:

V 2
eff =

∫ ∆f

0

v2
n (f) df = v2

n (f) ∆f

where vn (f) is the rms noise voltage normalized at 1 Hz, and is supposed to be
constant in the bandwidth of analysis ∆f.

So, measuring a noise consists in giving its rms voltage normalized at
1 Hz AND the bandwidth in which this power is measured !

Be aware that two noises may have the same PSD and very different time
traces. An example of this is given on the figure 1.1 :

time

time

b 1t 

b2t 

frequency

Power Spectral Density
DSP b2

=DSP b 2

V 

V 

s 

s  Hz 

W /Hz 

Figure 1.1: Two different noises with the same PSD.
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P1 What is the shape of these two noise histograms? Are their autocorrelation
functions identical ? Which one is a white noise? Which one is a Gaussian
noise?

3 Amplification noise

We need a low-noise and high gain amplifier to measure the thermal noise of
a resistance or the photon noise.

However, the amplifier produces its own noise. The aim of this part is to
measure the amplifier noise.

This amplifier noise is the output noise of the complete electronic system,
added to an amplified signal. Its rms value is noted Vampli,out. In order to com-
pare amplifiers with different gain and bandwidth values, the input rms noise
voltage normalized at 1 Hz, is given. We consider then a noise generator at the
input of an amplifier as shown in figure 1.2. We have to measure the rms noise
voltage vn,ampli (in V/

√
Hz ) of this white noise.

G , f

v n,ampli
v out

Figure 1.2: Input white noise model. G is the amplifier gain and
∆f is its bandwith

The circuit diagram we will use is drawn on the figure 1.3: It corresponds to
« Ampli 1 » aluminium box, with a grounded input. To shortcut the entrance,
use the box of resistances connected directly to the Ampli 1 box input, and
choose the R = 0 Ω position. The amplifier is powered by batteries (±12 V) to
avoid additional noise.
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ampli
Ve Vs

+15V

­15V

R

Ampli 1 : Bruit thermique

Figure 1.3: Amplifier noise and thermal noise measurements cir-
cuit.

3.1 Noise measurement with an oscilloscope.

 Observe the output signal with the oscilloscope (1 or 2 mV/division).

Q1 Observe the output voltage when you change the time scale. Does the
shape of the noise seem compatible with a Gaussian white noise?

Q2 Measure approximately Vpeak to peak of the noise observed on the oscillo-
scope. Assuming this noise is a Gaussian noise, we know that : Vpeak to peak
≈ 6VRMS .
Deduce the Root Mean Square (RMS) value (Vampli, out) of the amplifier output
voltage.

Furthermore we suppose that the amplifier gain is 300 and constant over a
bandwidth of ∆f = 1, 5 MHz (Bode Diagram in appendix)

Q3 What is the relationship between vn,ampli and Vampli,out? Deduce from your
measurement the rms input voltage noise of the amplifier vn,ampli and compare
to the AH0013 datasheet typical value: vn,AH1003 = 2 nV/

√
Hz

3.2 Noise measurement with a spectrum analyzer

With a spectrum analyzer (Tektronix 2712 for example), one can measure the
PSD of the noise (scheme in appendix).

The SA displays the electric power of its input voltage in W or in dBm
signal, dissipated in its input resistance RSA = 50 Ω.
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If this signal is a sine wave at frequency f0 v(t) =
√

2Vrms sin (2πf0t+ φ), the
displayed power is P (f0) =

V 2
rms
RSA

.

If this signal is periodic, the SA displays the power of each spectral compo-
nent of the signal

If this signal is a noise, the SA displays the signal PSD, integrated over the
resolution bandwidth δf = RBW around f0:

P (f0) =
1

RSA

∫ f0+ δf
2

f0− δf2
v2
n (f) · df (in W )

If we assume that the PSD is constant over δf :

P (f0) =
1

RSA
· v2
n (f0) · δf (in W )

Dividing this value by the resolution bandwidth, the SA measures the PSD (in
W/Hz) of the electrical signal :

PSD (f0) = P@1 Hz (f0) =
v2
n (f0)

RSA
(in W/Hz )

Reminder: Remember that dBm is a logarithmic power unity. ’m’ means that
the reference is 1 mW. A power in dBm is given by: PdBm = 10 log10

(
P

1 mW

)
where P is expressed in mW. So, 0dBm is 1 mW, −30dBm is 1µW ,
−60dBm is 1 nW, etc.
A PSD is given in dBm@1 Hz: P@1 Hz , dBm = 10 log

(
P@1Hz

1 mW

)

 Connect the output of the amplifier to the spectrum analyzer input. Mea-
sure P@1 Hz (300 kHz) in dBm, the amplifier noise output power spectral density
at 300 kHz.

Q4 Using Excel, calculate the corresponding noise voltage, vn,out(300 kHz),
at the amplifier output expressed in V /

√
Hz. The SA input resistance is RSA =

50 Ω.

Q5 Determine the value of the amplifier gain at a frequency of 300 kHz from
the Bode diagram of the amplifier given in Appendix. Deduce the rms input
noise voltage vn,ampli. Compare it to the value obtained in the previous section
and to the datasheet value for the low noise amplifier AH0013: vn,AH1003 =

2 nV/
√

Hz.
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Q6 Observe the output noise voltage of the amplifier for a larger span of
frequencies from 0 to 2 MHz. Is it a white noise? Why? Compare to the
Bode diagram (ampli Johnson noise) given in appendix. Explain why we can
measure the Bode diagram of the amplifier by this method.

 Check your calculations and your measurements with lab instructor.

4 Thermal resistance noise

With this amplifier it is easy to study the thermal noise (Johnson noise) of a
resistance.

Voltage fluctuations across a resistor R at the absolute temperature T is a
Gaussian white noise called thermal noise or Johnson noise. The rms noise
voltage is given by the Johnson-Nyquist formula:

vn,R =
√

4kTR in V/
√

Hz,

where k is the Boltzmann constant: k = 1.380× 10−23 J.K-1

A resistance can be replaced by a noiseless resistance R∗ with a noise volt-
age generator of rms value vn,R as represented in the figure 1.4.

v n,R
R

R
✶

Figure 1.4: Resistance thermal noise model

The low noise amplifier studied previously can be used to study the thermal
noise of a resistor connected between the amplifier input and ground.

4.1 Influence of the resistance

 With the spectrum analyzer, measure P@1 Hz (300 kHz) in dBm (output
noise PSD at the frequency of 300 kHz) for different resistors connected to the
amplifier input.

Q7 Deduce the amplifier rms voltage output noise, vn,out(300 kHz), for these
resistances (fill up the table started at question Q4).

At the entrance of the amplifier, we have two sources of noise,

• the amplifier noise, measured at question Q5,
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• the resistance thermal noise.

We can represent these two noises by two white noise generators placed at
the input of the amplifier (figure 1.5).

These sources are statistically independent. Therefore, the total noise power
is the sum of the powers of these two noise generators.

G , f

v n,ampli

v outR
✶

v n,R

Figure 1.5: Model of the thermal noise of a resistance, at the in-
put of a noisy amplifier.

Q8 With Excel, deduce from the previous measurements the rms noise volt-
age normalized at 1 Hz, vn,R of the thermal noise for each resistance. Do not
forget to take into account the noise of the amplifier.

Q9 Trace on the same graph the curves vn,R = f
(√

R
)

deduced from your
measurements and from calculation using the Johnson-Nyquist formula.

Q10 Observe the noise voltage output of the amplifier for a larger frequency
span from 0 to 2 MHz when you increase the value of R. Can you explain what
you see? Deduce why the measured noise is different from the theoretical noise
for the high resistance values.

Q11 Comparing the theoretical and experimental slopes for the small values
of resistance, evaluate the systematic error measurement in dB probably due
to a calibration default of the spectrum analyzer.

Important To take into account and therefore correct this error later in the
lab, keep the same settings of the spectrum analyzer.
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4.2 Influence of the temperature

To measure the influence of the temperature, you will put a resistance (pro-
tected in a box) in liquid nitrogen and thus compare the noise at room temper-
ature and at liquid nitrogen temperature. This simple experiment shows the
principle of a noise thermometer by measuring the thermodynamic tempera-
ture.

 Connect the resistance protected by a small metal box to the amplifier
input.

Q12 Measure, using the spectrum analyzer, P@1 Hz (300 kHz) in dBm, PSD of
the output noise at a frequency of 300 kHz, when the resistance is at room
temperature. Deduce the rms noise voltage normalized at 1 Hz, vn,R,T1

. Do not
forget to take into account the noise of the amplifier.

Q13 Repeat this measurement when the resistance is placed in liquid nitro-
gen. Deduce the rms noise voltage vn,R,T2 at this temperature. Use this mea-
surement to deduce the temperature of liquid nitrogen as accurately as possi-
ble.

5 Photon noise

The photon noise is related to the statistical fluctuations of the photons col-
lected by the photodetector. The photon counting statistics is known to be
Poissonian: if the detector surface receives N photons in average during an
integration time τ , the standard deviation of the number of photons received
is
√
N.

The photoelectrons created in the detector obey the same Poissonian statis-
tics and this explains the shot-noise (often called photon noise) on the pho-
tocurrent. The average photocurrent is Iph and the variance i2n,phof the fluctu-
ations is given by the Schottky formula:

in,ph =
√

2eIph (in A/
√

Hz ) where e is the electron charge e = 1.6× 10−19 C

A photodiode (detecting a Poissonian flux of photons) can be represented
by a DC current generator Iph, in parallel with a current noise generator:
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i n , phI ph

Figure 1.6: Photodetection noise model.

This current noise will be amplified by the circuit of the figure 1.7 :

anode

cathode

battery :  +24V

Iphot

photodiode

amplifier Vs

Rc=330

R=100

Ω

Ω

Amplifier  :  "photon noise"

1uF

DC Voltmeter

low noise

Figure 1.7: Amplifier : "photon noise"

The DC component of the current Iph passes through the two resistances
R1 and R2. We can deduce its value from the measurement of the voltage V
across R2 (100 Ω): Iph = V/R2. The photodiode is reverse biased with 24 V DC
supplied by a battery (noiseless).

 Connect the photodiode and the battery. Place the photodiode in front of
a white light source which intensity is adjustable. The photodiode is an E.G.G.
C30809 photodiode whose quantum efficiency is 0.83 at 900 nm (datasheet in
appendix).

A voltmeter connected to the output Iphot of the box measures the DC
photonic current delivered by the photodiode.

 Check the average photocurrent increases with the flux received by the
photodiode (do not go above 10 mA, 1 V on the voltmeter).

 Observe the noise output voltage of the amplifier using the oscilloscope
and the spectrum analyzer when increasing the flux.
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Q14 Observe the output noise for a span from 0 to 2 MHz. Is the shot noise a
white noise? How is it varying with the flux received by the photodiode?

Q15 Measure, using the spectrum analyzer, P@1 Hz (300 kHz) in dBm, PSD of
the output noise at a frequency of 300 kHz, for different average photocurrents
Iph from 0 to 10 mA. Deduce the rms noise voltage vn,out(300 kHz) for these
values of Iph.

At the entrance of the amplifier, we have now three sources of noise:

• the photon noise vn,ph = R1 · in,ph,

• the resistance (R1 = 324 Ω) thermal noise, vn,R1 ,

• and the amplifier noise, vn,ampli.

Note that the R2 resistance is not taken into account here because it is
short-circuited by the capacitor in parallel. The complete noise model of the
photodetection is given by the circuit in Figure 1.8:

G , f

v n,ampli

v out
R1

✶=324

v n,R 1

i n , ph

G , f

v n,ampli

v out

R1
✶=324

v n,R 1
v n, ph

Figure 1.8: Photodectection noise model.

These noise sources are statistically independent. So their noise powers can
be summed in order to find the total noise power:

v2
n,tot = v2

n,R1
+ (R1 · in,ph)

2
+ v2

n,ampli (vn,tot in V/
√

Hz )

The noise measurement when Iph = 0 mA gives the measurement of the am-
plifier and thermal noises.

Q16 Determine the value of the amplifier gain at a frequency of 300 kHz from
the Bode diagram of the amplifier given in Appendix, deduce the voltage noise
at the input of the amplifier: vn,tot.

Q17 With Excel, calculate the rms noise current in,ph taking into account the
systematic error determined in question Q11.
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Q18 Plot: in,ph = f
(√

Iph

)
. Compare with the values given by the Shottky

formula.

Q19 Evaluate the uncertainty if the uncertainty on the displayed noise value
is 0.3dB.

 Check your calculations and your measurements with the lab instructor.

6 Noise reduction

This last part presents a way to measure a photocurrent with a noise power
below the shot-noise limit. This experiment will prove that the photodetector
is not responsible for the shot-noise. Shot-noise is related to the quantum
nature of light and the shot-noise limit is due to the Poissonian statistics of the
collected photons. This experiment will show that a suitable light source can
give a sub-Poissonian statistics of photons collected and consequently leads to
a reduction of noise.

The idea is here to use, as a light source, a high quantum efficiency light-
emitting diode (Hamamatsu L2656 whose quantum efficiency is about 0.15
photons per electron at center wavelength of 890 nm). We put this LED as close
as possible to the photodiode (E.G.G. C30809) to collect the largest number
of photons we can (we took off the window of the photodiode, and both the
LED and the photodiode are in a metal box).

The figure below explains the principle of the shot-noise reduction experi-
ment:
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Figure 1.9: Principle of the shot-noise reduction experiment

Figure 1.10 represents the circuit which drives the LED either with a very
low noise current produced by an usual stabilized power supply (KIKUSUI)
or with a “Poissonian” current produced by three photodiodes illuminated by
an ordinary white light source. Changing the light level will change the mean
current through the LED. It is easy to adjust the stabilized power supply and
the light level in a way to get exactly the same mean current in the LED. This
current, ILED , is measured by a voltmeter in parallel with the 300 Ω resistance.

LED

anode

cathode

GBF alimentation
stabilized +24V

photodiodes

switch

C=22nF

100k

330

100

to Amplifier 1

(I led)

Ω

Ω

Ω

1k Ω

to DC voltmeter

(I led noise)

Figure 1.10: Setup of the sub-Poissonian/Poissonian light emit-
ting device
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6.1 Connecting the circuit

 Replace the photodiode of the previous part by the photodiode which is in
the small box “photodiode + LED”.

 Connect a second voltmeter at the ILED output to measure the average
current in the LED. Connect the stabilized power supply and the bias voltage
polarization for the 3 photodiodes (24 V) to the commutation box. Do not
connect anything to the input “GBF”.

 Put the switch on the “stabilized power supply” position and adjust the
photocurrent in the photodiode at exactly 3 mA.

 Put the switch on the “Poisson current” position, and adjust the flux on
the 3 photodiodes in order to get the exactly same photocurrent (3 mA) in the
photodiode.

6.2 Measurement

Q20 Measure the current in the LED and deduce the total quantum efficiency
ηT , i.e. the number of electrons delivered by the photodiode per second divided
by the number of electrons crossing the LED per second.

Q21 With the spectrum analyzer, measure P@1 Hz (300 kHz) in dBm. Check
that you find exactly the same value as in the previous part (Q15). This proves
you are at the shot noise level.

Q22 Deduce the rms noise current in,ph.

 Switch to the “stabilized power supply”position. Check that the DC current
is still Iph = 3 mA.

Q23 Measure P@1 Hz (300 kHz) in dBm. Deduce the rms noise current in,ph.

Q24 What noise reduction (in dB) do you find?

Q25 Compare to the value calculated as explained in the next paragraph.
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To obtain a better visualization of the noise reduction, you can display the
spectrum on 5dB/div scale. Then you can average the spectrum on the “Poisso-
nian current” position and save it. At last, average the spectrum on “stabilized
power supply” position and save it.

 Ask the lab instructor how to use the average function of the spectrum
analyzer.

6.3 Simple explanation of the noise reduction

When a constant current source is used to drive the LED, the noise on the
current is very low. The fluctuations of the number of electrons crossing the
LED are very low in comparison with a “Poissonian statistics”. If the quantum-
efficiency of the LED was equal to one, the fluctuations of the number of pho-
tons emitted by the LED and collected by the photodiode would be very low
too. The resulting noise reduction would be very large.

Unfortunately, the total quantum efficiency, ηT = ηPhD · ηLED , is only about
0.17. This means that for six electrons crossing the LED only one electron on
average will be generated by the photodiode.

If we suppose that the current in the LED is noiseless, the number of elec-
trons through the LED, Ne,LED, during a time τ , is constant. The number of
electrons generated by the photodiode during a time τ is thus given by a bino-
mial distribution. The mean value and the variance of the number of electrons
crossing the photodiode during a time τ are:

Ne,photodiode = ηTNe,LED

and:
σNe,photodiode =

√
ηT (1− ηT )Ne,LED

This leads to:

Iph =
Ne,photodiode

τ
e = ηT

Ne,LED

τ
e = ηT ILED,

and the rms value irms,ph of this photocurrent:

irms,ph =
σNe,photodiode

τ
e =

√
ηT (1− ηT )Ne,LED

e2

τ2

The bandwidth is δf = 1/2τ, so the photocurrent noise is:

irms,ph =
√

2eIph (1− ηT ) δf (in A )

instead of
irms,ph =

√
2eIphδf
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for the shot noise. Thus, the noise power reduction is:

Preduced

Pphoton
= 1− ηT

In dB:

Preduction,dB = Preduced,dBm − Pphoton,dBm = 10 log (1− ηT )

7 Short guidelines for the redaction of the report

For the report, please do not answer all the questions of the text linearly and
do not describe all your experimental procedures. Please explain for all three
configurations what are the contributions to the noise, their nature and their
rms levels. A particular attention will be paid to the graphs in Parts "Thermal
resistance noise" (influence of the resistance) and "Photon noise". Thus, We
expect you to establish a brief overview of the noise levels in the different
setups under study. Redaction of the last part "Noise reduction" is optional, but
will be strongly taken into consideration if satisfying.

References on noise reduction

[1] Introduction à la réduction du bruit quantique. S. Reynaud
Ann. Phys. Fr. 15, 63 (1990).

[2] Sub-Shot-Noise Manipulation of Light Using Semiconductor Emitters and
Receivers. J.-F. Roch, J.-Ph. Poizat and P. Grangier
Physical Review Letters Vol 71, Number 13 (1993)



18 B 1. PHOTODETECTION NOISE SOURCES

Appendix 1. Bode diagrams of the amplifiers
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Appendix 2. The spectrum analyser
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Infrared detector
characteristic measurement

Version: January 19, 2023

You should read carefully this text and prepare the questions P1-P12 be-
fore the lab.
Data analysis have to be done and checked during the lab session.
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2 Detector characteristics . . . . . . . . . . . . . . . . . . . 22

3 Measurements . . . . . . . . . . . . . . . . . . . . . . . . 26

4 Analysis of the measurements . . . . . . . . . . . . . . . 33

5 Writing down the report . . . . . . . . . . . . . . . . . . . 34

Appendix 1 - Black body spectral radiance . . . . . . . . . . . 36

Appendix 2 - Atmospheric transmittance . . . . . . . . . . . . 36

Appendix 3 - Spectral detectivity . . . . . . . . . . . . . . . . . 37

1 Objectives

At the end of the session lab, you will be able to:

• measure the performance of an infrared detector, which means being able
to:

21
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– identify the relevant parameters (dark current, quantum efficiency,
black-body response, noise , detectivity);

– identify the specificities of the IR domain (black-body radiation, am-
bient background, dark current of the detector);

– use a digital spectrum analyzer and understand the need for an an-
tialiasing filter and an appropriate window;

– understand the rational behind the use of a chopper;

– be able to compute the etendue of the measurement setup;

– evaluate the uncertainty of each measurement;

• propose a measurement procedure that can be used to verify if an IR
detector is limited by the background photon noise (BLIP).

During this lab, we will therefore measure the characteristics of an IR detec-
tor cooled to 77 K by liquid nitrogen.
The detector is an InSb photodiode (sensitive in the 3–5 microns spectral
band), with model reference P5968-100 Hamamatsu. The diameter is 1 mm
and the total angle of view is 60◦.
The full characteristics of the detector can be found online:
http://jp.hamamatsu.com

This lab will provide an opportunity to apply concepts learnt in the course of
photometry and detectors noise, and to familiarize with conventional experi-
mental techniques. Measurements are relatively simple and fast, but they must
be understood and analyzed with care.

P1 For which applications, one may use infrared detectors? Give at least
3 examples. Describe the different families of infrared technologies and give
their specificities.

2 Detector characteristics

2.1 Spectral response of a photonic detector

The spectral response R (λ) of a photodiode detector is defined for a stationary
monochromatic flux Φλ,

R (λ) =
Iph

Φλ
in A /W,

where Iph is the mean current across the photodiode.

'http://jp.hamamatsu.com'
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A photodiode is a quantum detector,i.e. a photon counter. So the current in
the photodiode is easily related to the number of photons received per second,
nph,λ,

Iph = η (λ) ·nph,λ · e,

where e is the electron charge and η (λ) is the quantum efficiency (photon to
electron conversion).

P2 Show that the spectral response of the detector is given by

R (λ) =
Iph

Φλ
=
λ · η (λ) · e

h · c
in A W,

where h is the Planck constant h = 6.626× 10−34 J s.
We also define the relative spectral response of the detector:

S (λ) =
R (λ)

maxR (λ)
=

R (λ)

R
(
λpeak

)
P3 Explain why, if the quantum efficiency is constant, the spectral response
S(λ) for λ < λpeak is a linear function as represented on Figure 2.1.

0 pic



1

0 pic

S 

1

Figure 2.1: Spectral responsivity.

We will study an InSb detector whose cut off wavelength is: λc = 5.5µm.
The value corresponding to the peak of sensibility is λpeak = 5.3µm.

P4 Calculate the maximal response R (λc) of a InSb detector at λc = 5.3µm
assuming the quantum efficiency is equal to 1.

The relative spectral response of the studied detector is obtained by compar-
ison with a detector which spectral response is well known. For this purpose,
one may use a pyroelectric detector as a reference. It is a thermal detector that
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has a constant spectral response. Some previous measurements are available
on the computer.
See file sensibilite_relative_insb.xls.

2.2 Background infrared radiation

For IR detectors, the background photon flux detected is generally very large
compared to the flux (signal) we want to measure (this explains why we need
a chopper in front of our source in our setup). The black body emission of
the whole scene at room temperature viewed by the detector is responsible
for this large flux of background photons. This flux will be converted in a DC
current, Iph,BG. To determine this current, one needs to calculate the flux of
background photons using Planck photonic black body law.

P5 Show that if the FOV (Field Of View) of the detector is 2α, the flux of
photons received by the detector is:

nph,BG = πAd sin2 α ·Lph,BG (in s−1 ),

where Ad is the area of the detector, and Lph,BG is the photonic total radiance
between 2 and 5.5µm,

Lph,BG =

5.5µm∫
2µm

[
dLph

dλ

]TBG

dλ (in s−1 m−2 sr−1 ).

The spectral photonic radiance is given by[
dLph

dλ

]T
=

2c

λ4

1

e

hc

λkT − 1

(2.1)

where h is the Planck constant (h = 6.626× 10−34 J s) and k is the Boltzmann
constant (k = 1.38× 10−23 J K−1).

P6 Calculate nph,BG for our detector (the diameter is 1 mm and the half angle
α = 30◦) if we assume that the quantum efficiency is 1 on the wavelength range
2− 5.5µm. Calculate the corresponding DC current Iph,BG.

 The total photonic radiance has to be calculated by integration of the spec-
tral photonic radiance (2.1) on the wavelength range 2− 5.5µm. This integra-
tion can be done numerically with Matlab or Excel or using the webpage:
http://www.spectralcalc.com/blackbody_calculator/blackbody.php

http://www.spectralcalc.com/blackbody_calculator/blackbody.php
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2.3 Background photon noise limit

The fluctuation of this flux of background photons is generally the main source
of noise for IR detectors (these detectors are Background Limited Infrared Pho-
todetectors or "BLIP") .

In this case, the noise current measured in a 1 Hz equivalent Bandwidth is
given by the Schottky formula :

in,BG =
√

2eIph,BG (in A /
√

Hz)

P7 Deduce in,BG from the current Iph,BG calculated in question P6.

2.4 N.E.P.: Noise Equivalent Power

The Noise-Equivalent Power (NEP) is the radiant power that produces a signal-
to-noise ratio of unity at the output of a given optical detector at a given mod-
ulation frequency, operating wavelength, and equivalent noise bandwidth.

NEP (λ) = ∆Φpp (λ) =
inoise, rms

R (λ)
in W

In other words the N.E.P. gives the smallest detectable variation of IR flux.

P8 Explain why the NEP is proportional to the square root of the effective
bandwidth.

P9 For a BLIP detector, explain why the NEP is proportional to the square root
of its surface?

Because the NEP is proportional to the square root of the detector surface
and to the square root of the ENBW (Equivalent Noise Band Width), in order
to compare different IR detectors we have to define the ratio:

NEP (λ)√
Ad
√

∆f

where Ad is the detector area and ∆f is the Equivalent Noise Band Width
ENBW.
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2.4.1 Spectral Detectivity

The detectivity, preferred by the manufacturers, is the inverse of the quantity
defined above because the higher the detectivity, the better the detector is:

D∗ (λ) =

√
Ad
√

∆f

NEP (λ)
= R (λ)

√
Ad
√

∆f

inoise, rms
= R (λ)

√
Ad

inoise, rms.@1Hz

where inoise, rms.@1Hz is expressed in A/
√

Hz, D∗ (λ) in cm
√

Hz/W, as the de-
tector area is expressed in cm2 .

The maximal value is obtained for λpeak and is called peak detectivity
(D∗peak).

P10 What is the value of D∗peak according to the datasheet ?

2.5 Black body Detectivity

A direct measurement of the spectral detectivity versus the wavelength is diffi-
cult. So we will first measure the Black Body Detectivity (the detector is illu-
minated by a black body at 500 K). Then we will measure the relative spectral
response of the detector S(λ).

The Black Body Detectivity D∗BB(TBB, f,∆f) is:

D∗BB (T
BB
, f,∆f) = RBB

√
Ad
√

∆f

inoise, rms. (f)

=
Iph

ΦBB,TBB

√
Ad

inoise, rms.@1 Hz (f)

in cm
√

Hz/W, where TBB is the black body temperature, f the modulation
frequency and ∆f the ENBW.

P11 For which values of TCN, f,∆f is the black body detectivity given in the
datasheet?

Remark From the measurements ofD∗BB(TBB, f,∆f) and S(λ) we will deduce
D∗(λ) for this detector (see paragraph 4).

3 Measurements

The circuit diagram is given in Figure 2.2.
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+
-

 

I p h

Detector

DC Output

Output

-
+

R C

V 0

Current to voltage converter + adjustable gain

Figure 2.2: Circuit diagram.

P12 What is the name of the first stage of the detection circuit? What is the
link between V0 and Iph? What is the bias voltage? What is the function of the
second amplier? How about the RC filter between the two amplifiers?

3.1 Measurement of the current due to the background in-
frared radiation

 Connect the detector to the amplifier box and the voltmeter to the DC
output. Connect the output to the oscilloscope.

 Pour slowly and carefully liquid nitrogen into the cryostat and wait for the
signal apparition.

Q1 Measure the DC voltage. Deduce the value of Iph,BG and, compare it with
the value determined at question P6.

3.2 Measurement of the detector noise

 Connect the output of the amplifier box to the filter box.

3.2.1 Noise measurement with an oscillloscope

 Display the signal on the RIGOL oscilloscope. Choose properly the value
of Rc and of the different gains in order to obtain a correct signal amplitude
without any saturation.
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Q2 Where does this noise come from? Assuming this noise is Gaussian, mea-
sure Vnoise,rms with the oscilloscope (you can use the theoretical framework pro-
vided by the subject of Labwork 9, and we remind you that Vnoise,rms = Vpp/6
for a Gaussian noise).

Q3 The bandwidth of the anti-aliasing filter is about 2 kHz. Assuming the
noise is a white noise on this bandwidth, calculate vnoise,rms@1Hz in a 1 Hz
analysis bandwidth (rms noise voltage in V /

√
Hz). Deduce the current noise,

inoise, rms.@1Hz , in the photodiode for an equivalent bandwidth of 1 Hz (current
noise normalized in A /

√
Hz). Compare to the value obtained in preparation

(P7).

3.2.2 Accurate noise measurement with a FFT spectrum analyzer

 Connect the signal on the 1st input channel of the LeCroy analyzer.

 Upload the setup file named TPDetIR HistBruit. To do so, go to the
menu File>Recall Setup.

 Click on the C1 yellow frame, located just below the plot area. Check that
the coupling parameter is set to DC1MΩ. Change the parameter value if needed.

Q4 Can we consider that the noise measured by the analyzer is Gaussian?
Explain why this approximation is physically relevant.

 Now, upload the setup file named TPDetIR TFBruit in the menu File>Recall
Setup. Check that the coupling parameter is still set to the correct value.

Q5 Is the measured noise a white noise? Was it expected?

Q6 Explain the role of the anti-aliasing filter. Where do you see its influence?
Why is it necessary for this measurement? How should we choose the sampling
frequency?

The background photon noise (detector noise) and the amplification noise
are both responsible for the measured noise. These noise sources are statisti-
cally independent so:

vtotal,rms =
√
v2

noise,rms + v2
ampli,rms
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 Go to the Cursors menu and select Horizontal Abs. Display the cur-
sor settings in Cursors>Cursor Setup and select Hz as the X - axis pa-
rameter. The x-coordinate (frequencies) of the cursor is displayed on the right
of the screen, its y-coordinate is displayed in the red and blue frames inti-
tled F1 and F2 respectively. We remind you that PdBm = 10 log

(
P

1mW

)
where

P = V 2/1MΩ.

Q7 Measure the noise voltage at the ouput for 500 Hz. Then, for the same
frequency, measure the noise voltage at the output when the detector is dis-
connected. Deduce the detector noise voltage vnoise,rms and the current noise of
the detector inoise,rms.

Q8 Note the value of the equivalent noise bandwidth ∆f displayed in the
FFT panel that appears when you click on de red F2 frame. Deduce the noise
current of the detector in 1Hz bandwidth inoise,rms@1Hz. Compare to the value
obtained in preparation (P 7). Is the detector BLIP?

3.3 Measurement of the black body response of the IR de-
tector

To measure the black body response of the IR detector,

RBB =
∆Iph

∆ΦBB
in A /W

we will have to:

• determine precisely the flux variation received by the detector,

• measure carefully the photocurrent induced by this flux variation.
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3.3.1 Set-up

Current to voltage amplifier

IR Detector

Black body (500 K)

Chopper

Diaphragm

Oscilloscope
Data acquisition

Anti­aliasing filter

Figure 2.3: Set-up

When the chopper is turning, the detector sees through the diaphragm alter-
nately a black blade at room temperature or the black body at 500K.

Do not change the temperature settings of the black body!

3.3.2 First measurement using an oscilloscope

 Set the modulator frequency to 500Hz.

 Place the detector precisely at 1 meter from the diaphragm (Detector is at
(9± 1)mm behind the window).

 Align carefully the Black Body, the diaphragm (we will choose a diameter
φ = 5 mm) and the detector.

 Optimize the signal by improving your alignment.

Q9 Measure the peak to peak voltage without anti-aliasing filter.

The flux variation ∆Φ(t) is periodic and can thus be decomposed as a Fourier
series. One can then calculate the RMS value of its fundamental component
∆Φrms. One can show that RMS value is related to the peak to valley of the flux
variation Φpp by the Modulation Factor (M.F.):

MF =
∆Φrms

Φpp
=

∆Φrms

Φmax − Φmin
(2.2)
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W

d
Φmax

Φmin

Φ(t) flux variation

t
Modulator
W : length of the arc between 2 blades in front of the diaphragm
d : diaphragm diameter

Figure 2.4: Chopper

For a square signal (case d << W ):

MF =

√
2

π
= 0.45

Q10 Show that the modulation factor for a square signal is:

MF =
∆Vrms, 500 Hz

Vpeak to peak
=

√
2

π
= 0.45

Deduce a value of ∆Vrms,500 Hz.

Q11 Deduce a value of ∆IBB, rms,500 Hz.

3.3.3 Measurement of the signal obtained by the FFT method

 Add the anti-aliasing filter (low-pass filter, cut-off frequency of 2 kHz) and
connect the output signal to the LeCroy analyzer.

 Go to the menu File>Recall Setup and upload the file TPDetIR TF
Signal. The P2 measurement channel gives the amplitude of the highest
peak, the one at 500Hz.

Q12 Measure the RMS voltage after the filter at 500Hz.

 Vary slightly the chopping frequency with an amplitude of ±20Hz.
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Q13 Note the effective value of the highest peak measured by the analyzer
during this variation. Explain the origin of these fluctuations. What is the influ-
ence of the acquisition window, the sampling frequency, Fe, and the influence
of the number of acquired points Ne? Explain why the “flat top” window is the-
oretically well fitted for this kind of measurement (you can use the appendix
for your explanations).

 Set back the frequency to 500Hz. In the FFT panel of F2 channel, select
the Flat Top window.

Q14 Measure the amplitude of the 500Hz peak. Knowing the gain of the am-
plifier and of the filter (in V /A), measure the current, ∆IBB, rms,500 Hz through
the photodiode. Evaluate the accuracy of this measurement.

 Check your result with the lab instructor.

3.3.4 Determination of the flux variation received by the IR detector

Calculation of the peak to peak flux variation

Q15 Measure the diaphragm - detector distance and calculate the etendue
between the detector and the diaphragm (the InSb detector diameter is 1 mm).

The black body radiance follows the Stefan law:

L =
σT 4

π

with σ = 5, 67.10−8 W /m2.K4

Q16 Calculate the peak to peak flux variation received by the IR detector
∆ΦBB,pp.

Calculation of the effective variation of the flux received by the detector

Q17 Using Eq. (2.2), calculate ∆Φrms,500 Hz received by the detector.

3.3.5 Black body response of the detector

Q18 Calculate the black body response of the IR detector RBB =
∆Iph

∆ΦBB
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 Check your result with the lab instructor.

3.3.6 Calculation of the black body detectivity

Q19 Deduce the black body detectivity D∗BB(TBB, f,∆f). Evaluate the accu-
racy of your measurement.

The detector noise is normally mainly due to the photon noise of the ambiant
photons. In this case, the noise of the detector depends on the field of view
(FOV).

Q20 Explain why the noise of the detector depends on the FOV. How should
D∗BB(TBB, f,∆f) be corrected to be compared with a 2π steradian detector?

4 Analysis of the measurements

In this section, no measurement is required. However, you will need the file
sensibilite_relative_insb.xls which is saved on the computer of the
room. Do not forget to make a copy of the file.

Spectral Response and spectral detectivity

With the measurements of the black body Response, RBB and the relative spec-
tral Response, the spectral response can be deduced:

γ =
R
(
λpeak

)
RBB

The photonic current is given by

∆Iph = RBB∆ΦBB

with :

∆ΦBB = MF×σ
π

(
T 4

BB − T 4
BG

)
U

where U is the etendue, MF is the modulation factor, BB refers to the blackbody
temperature and BG to background temperature.
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E1 Explain why the photonic current can also be calculated by integration of
the black body radiance :

Iph = MF× U ×
∫ ∞

0

R (λ)

([
dL

dλ

]TBB

BB
−
[
dL

dλ

]TBG

BG

)
dλ

= MF× U ×R
(
λpeak

) ∫ ∞
0

S (λ)

([
dL

dλ

]TBB

BB
−
[
dL

dλ

]TBG

BG

)
dλ

where
[
dL
dλ

]TBB

BB and
[
dL
dλ

]TBG

BG are the spectral radiances of the black body at
temperature at TBB and TBG, given by :[

dL

dλ

]T
BB

=
2hc2

λ5

1

e

hc

λkT − 1

where λ expressed in m, dLdλ in
(
W · m−2 · sr−1

)
/m

E2 Deduce the ratio γ :

γ =
σ
π

(
T 4

BB − T 4
BG

)∫∞
0
S (λ)

([
dL
dλ

]TBB

BB −
[
dL
dλ

]TBG

BG

)
dλ

E3 Perform this calculation using Excel.

E4 Calculate R(λpeak) and give the representation of the spectral Response
R(λ). Plot also the spectral quantum efficiency curve.

E5 Using γ, calculate D∗peak = D∗(λpeak) and plot the spectral detectivity
curve D∗(λ).

5 Writing down the report

In your report, you do not have to linearly describe your measurement proto-
cols and your results. However, you should write a well structured document
(between 2 and 6 pages maximum with an introduction, a conclusion, several
parts, etc.) where you will summarize:

• the major concepts related to the technology you studied in the labwork,

• the key points and challenges of the characterization of an IR detector,
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• your conclusions of the performance of the detector you studied during
the labwork.

Your comments should be based on your measurements. You may also com-
pare your observations on the infrared technology with what you know about
sensors in the visible range.
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Appendix 1 - Black body spectral radiance

Figure 2.5: Black Body spectral radiance

Appendix 2 - Atmospheric transmittance

Figure 2.6: Atmospheric transmittance
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Appendix 3 - Spectral detectivity

Figure 2.7: Spectral detectivities of IR detectors
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CMOS sensor

Version: January 19, 2023

Questions from P1 to P5 should be prepared before the session.
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4 Measurement of the read-out noise . . . . . . . . . . . . 43
5 Study of the dark signal . . . . . . . . . . . . . . . . . . . 44
6 Study of the sensor linearity and photon noise . . . . . . 45
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1 Introduction

Nowadays, the vast majority of cameras produced are CMOS (Complementary
Metal Oxyd Semiconductor) cameras: they have imposed themselves in front
of CCD (Charge-Coupled Device) cameras. The main difference between the
two technologies is that each pixel of a CMOS sensor possesses its own read-
out circuit (charge-voltage converter and amplifier), directly next to the pho-
tosensitive area. Compared to the CCD technology, the benefits of the CMOS
technology are:

• Sensors easier to produce and thus cheaper,

• Low consumption,

39
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• Faster data reading,

• Each pixel can be individually controlled,

• Possibility to do image processing directly at the sensor level (definition
of regions of interest (ROI), binning, filtering, . . . )

The drawbacks of the technology are a lower dynamic range and a higher noise
level.

Figure 3.1: Left - CMOS e2V sensor studied during this session.
Right - diagram of the general principle of CMOS sen-
sors.

The goal of this session is to measure the characteristics of an industrial
µEye camera, equipped with a CMOS sensor, manufactured by e2V (1.3 Mpix-
els, 5.3× 5.3µm2 pixels). Figures 3.2 and 3.3 show some characteristics of the
sensor. We are specifically interested in the sensor linearity, the read-out noise,
the dark signal and the photon noise. The measured values will be compared
to the data given by the manufacturer.

Figure 3.2: Extract from the CMOS e2V sensor datasheet - spec-
tral response.
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Capteur EV76C560 Typical electro-optical performance @ 25°C and 65°C, nominal pixel clock 

 

Parameter Unit Typical value 
 

Sensor 
characteristics 

Resolution pixels 1280 (H) × 1024 (V) 
 

Image size mm 
inches 

6.9 (H) × 5.5 (V) - 8.7 (diagonal) 
≈ 1/1.8 

Pixel size (square) µm 5.3 × 5.3 
Aspect ratio  5 / 4 
Max frame rate fps 60 @ full format 
Pixel rate Mpixels / s 90 -> 120 
Bit depth bits 10 

 

Pixel 
performance 

 @ 25°C @ 65°C 
Dynamic range dB >62 >57 
Qsat ke- 12 
SNR Max dB 41 39 
MTF at Nyquist, λ=550 nm % 50 
Dark signal (1) LSB10/s 24 420 
DSNU(1) LSB10/s 6 116 
PRNU (2) (RMS) % <1 
Responsivity (3) LSB10/(Lux.s) 6600 

 
Electrical 
interface 

Power supplies V 3.3 & 1.8 
Power consumption:  Functional (4) 

Standby 
mW 
µW 

< 200 mW 
180 

1.             Min gain, 10 bits. 
2.             Measured @ Vsat/2, min gain. 
3.             3200K, window with AR coating, IR cutoff filter BG38 2 mm. 
4.             @ 60 fps, full format, with 10 pF on each output. 
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  du	
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Figure 3.3: Extract from the CMOS e2V sensor datasheet.

2 Preliminary questions

Each pixel of this CMOS sensor can be modelized by a photodiode and its pre-
amplification circuit. The output voltage of each pixel is then converted by a
10-bits analog-to-digital converter into a numerical value. This data is then
sent, pixel by pixel, to the computer by an USB link.

P1 Draw the acquisition chain with a focus on the kind of information that
go from a block to another.

The maximum number of photelectrons per pixel (Full Well) is a key param-
eter. The Full Well value sets the dynamic range and the signal to noise ratio
of the sensor.
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P2 According to the datasheet, the Full Well value is 12000e-. Knowing that
the signal is digitized over 10 bits, what is the equivalence between 1 bit-level
and the number of electrons?

Remark: This conversion factor (e-/bit-level) is often referred to as Gain in
datasheets and is expressed in e-/ADU (Analog-Digital Units).

P3 Assuming that the photon noise is the predominant source of noise, the
signal to noise ratio (SNR) is directly linked to the Full Well value. Calculate
the SNR in dB and compare your result to the value given by the manufacturer
(41dB).

The datasheet gives the following spectral response for the sensor: 45LSB
(10bits) for 1 nJ/cm2 for a wavelength of 600 nm (see Figure 3.4). This corre-
sponds to a quantum yield of 60%.

P4 Confirm that this quantum yield value is indeed compatible with the given
spectral response value.

3 Matlab interface and sensor learning

3.1 Matlab processing

The camera is controlled using a graphic interface developped on Matlab,
called GuiCamera.

Remark : In order to optimize the processing of the 10-bits acquired data
of each pixel, only the 8 most significant bits are stored by the GuiCamera
interface.

P5 What is the conversion factor you need to apply to obtain the real value
acquired on the sensor compared to the data stored by the GuiCamera program
?

3.2 Graphical interface

 Start Matlab.

 On the Matlab command window, enter: » GuiCamera

 Initialize the camera.
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 In the main window, click on the option : Zone d’intérêt (AOI) au centre de
la caméra.

 Click on paramètres to open the property window (see Figure 3.2).

Figure 3.4: Acquisition setting window

 Set the following acquisition parameters:

• In the Image tab, check that the Master Gain is set to 0 (Gain 1.00x) and
that the Gain, Black Level (offset) and the Gamma Auto-correction
boxes are unchecked.

• Set the Black Level to 255.

• In the Size tab, check that the binning along x and y is set to the normal
value.

• In the Timing tab, set the PixelClock to 30 MHz.

4 Measurement of the read-out noise

The read-out noise is an electronic noise that appears during the conversion of
the photoelectrons into voltage. This voltage is then digitized over 10 bits. To
measure this noise, the sensor should receive no signal at all, with an integra-
tion time set as small as possible (to suppress the dark signal).
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 Put the cap on the sensor. Set the integration time to its minimum value,
in the Timing tab of the Paramètres of the sensor.

 Display the image histogram using the Histogramme button.

Q1 Read off the mean value and the standard deviation (Ecart-Type) above
the histogram. What do these two values mean ?

 In the Image tab, modify the value of the Black Level and observe the
effect on the histogram. The Black Level is also called Bias. Observe the his-
togram for a Black Level value ranging from 0 to 255.

Q2 Explain the influence of the Black Level value. For the maximum value
(255), give the average value of the signal on the image. The read-out noise is
the fluctuation around this average value.

 Read off the value of the read-out noise observed on the histogram.
Remark : throughout the rest of the labwork session, you will set the Black

Level to 255.

5 Study of the dark signal

We now consider images acquired in the absence of any signal, for an increas-
ing value of the integration time. These images are often referred to as Dark
images.

The sensor does not receive any light and you are going to analyze its re-
sponse depending on the integration time.

 Read off the mean value and the standard deviation of the gray level of the
histogram, for an integration time ranging from 0 to 2 seconds (with a 250ms
step).

 Plot the curve of the dark signal as a function of the integration time (do
not forget to subtract the Black Level).

Q3 Compare your dark signal value to the one given by the manufacturer.
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 Observe the images for long integration times. Some pixels (referred to
as Hot Pixels) exhibit a much stronger signal. It is not a temporal noise but a
spatial heterogeneity of the dark signal. Does the shape of the histogram seem
to be gaussian ?

Q4 Compare the value of the standard deviation to the Dark Signal Non Uni-
formity (DSNU) value given by the manufacturer. How could you reduce this
value ?

6 Study of the sensor linearity and photon noise

The CMOS sensor is now placed in front of an integrating sphere in order to be
uniformly illuminated. The images obtained in this case are often called Flat.

 Set the integration time to 1 second.

 Power the integration sphere in order to obtain a gray level mean of 150.

6.1 Spatial analysis - Linearity

In order to measure the linearity of the sensor, one can measure the mean value
of the signal as a function of the integration time (do not forget to subtract the
read-out noise).

 Read off the mean value and the standard deviation of the signal for an
integration time ranging from 0 to 2 s (by step of 250 ms).

Q5 What can you say about the last point ?

 Plot the mean value of the signal as a function of the integration time.

Q6 Is the response of the sensor linear?

6.2 Temporal analysis - Photon noise

The photon noise can be estimated by measuring the signal temporal fluctua-
tion of a pixel for different incident photon fluxes on the sensor.

 Set the integration time to 50 ms
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 Power the integration sphere in order to obtain a gray level mean of 128.

 Observe the fluctuation of the signal of a pixel for this signal level.

Q7 Is the signal random ? What is the shape of the histogram ?
Remark : In order to obtain good statistical results, the observation must

be done for a large number of points (between 500 to 1000).

 Repeat this operation for differents gray levels (64, 128, 192...) and plot
the variance of the signal as a function of the mean level.

Q8 Can the measured noise be considered to be photon noise? Why?

Q9 Propose an explanation to justify the difference between the temporal
fluctuations of a pixel’s signal and the noise that you get by studying the his-
togram of the 200× 200-pixel area.

 Plot the signal to noise ratio as a function the mean value of the signal.
If the noise is indeed photon noise (i.e. Poisson noise), the fluctuation of

the number of photo-electrons per pixel is given by its standard deviation or its
variance:

σ2
Ne = 〈Ne〉

The number of photo-electrons is then digitized S10bits :

S10bits =
Ne
G

where G is the conversion factor (gain) in electrons per bit-level (e- / ADU).
The mean value of the digital signal is then

〈S10bits〉 =
〈Ne〉
G

and its variance is given by

σ2
S10bits

=
σ2
Ne

G2

It is thus possible to find the conversion factor (gain) in electrons per bit-level
(e- / ADU ) from the previous measurement:

G =
〈S10bits〉
σ2
S10bits
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Q10 Estimate the value of the conversion factor and compare your result with
the value obtained in P1.

6.3 Binning

Binning is the procedure of combining several pixels into a single pixel over one
or two dimensions. The charges contained in the combined pixels are added
together before digitalization. In order to improve the sensitivity or the signal
to noise ratio of the sensor, it is possible to measure the signal after combining
4 adjacent pixels (2× 2 binning). This improvement is done at the expense of
the resolution (the image resolution is then 640× 512).

Q11 Explain briefly why the binning allows one to increase the signal to noise
ratio. In this mode, what would be the maximum SNR (in DB)?

 In the Size tab, modify the Binning (×2 along x and y).

 Read off the mean value and the standard deviation of the histogram for
an integration time of 50 ms and gray levels around 64 and 128. What is the
value of the SNR ? Does it comply with your expectation ?

7 Measurement of the sensor spectral response

Figure 3.5: Schematic diagram of the measurement bench using
a monochromator

The monochromator allows one to choose the wavelength of the light sent on
the sensor. The input and output slits are 2-mm wide which gives a spectral
width of the order of 30 nm. After the monochromator, a collimator allows
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to illuminate the studied sensor under normally incident light. We use a PIN
10-D photodiode with a photosensitive area of 1cm2 to measure the illumina-
tion received by the sensor. The sensitivity of this photodiode is given in Figure
3.6.

 Power the monochromator light with a voltage around 20 V.

 Using the photodiode, measure the irradiance (in W/cm2) for the follow-
ing wavelength: 500, 600, 700, 800, 900 nm.

 Replace the photodiode with the CMOS sensor. Set an appropriate inte-
gration time. Measure the signal intensity in the center of the image for these
wavelengths.

 Deduce from your measurements the spectral response of the sensor in
gray level as a function of the received energy per cm2

(
ADU

nJ/cm2

)
 Plot the curve and compare it with the datasheet.

Q12 What is the quantum yield for these wavelengths?

 Plot the quantum yield as a function of the wavelength.
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Figure 3.6: Spectral response of the calibration photodiode
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8 Synthesis

In a brief report (2 pages maximum - except curves), you will explain to a man-
ufacturer who wants to test and calibrate his new CMOS sensor the different
steps he has to follow and the curves he has to produce. Your description will
be based on your experimental results.
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Thermal camera

Version: January 19, 2023

Do not forget to prepare the preliminary questions before the lab. Some
of them can be asked during the oral examination.

Contents
1 Objectives . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
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This lab will allow you to take in hand two infrared cameras of microbolome-
ter technology (figure 4.1), to characterize their performances then to ap-
proach two applications of infrared imaging.

The first part of the lab is devoted to the discovery of infrared and the
highlighting of certain properties of materials in the infrared (emissivity, trans-
parency/opacity...). Then, you will evaluate the performance of both cameras
by measuring their NETD (noise equivalent temperature difference). You will
then focus on two applications of infrared imaging: absolute temperature mea-
surement (infrared thermography) and non-destructive testing.

The lab report is due one week after the session. It must contain a descrip-
tion of the various measurements taken and an answer to all questions asked

51
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in the statement. Do not hesitate to include infrared images in the report to
illustrate your point.

Figure 4.1: Left : Microbolometer Focal Plane Array (credit : www.
ulis-ir.com). Right: a pixel (credit : http://www.
laserfocusworld.com).

1 Objectives

At the end of this session, you should be able to:

• explain the importance of the emissivity in infrared thermography;

• explain the working principles of the bolometric camera;

• evaluate the performance of an infrared camera for thermography, this
means to be able to:

– identify the parameters of interest (NETD, spatial noise, MRTD, . . . );
– propose procedures to measure such parameters;
– evaluate the uncertainty of the measurements;

• evaluate the precision of the temperature measurements carried out by
such a camera.

2 Presentation of the cameras

Be careful, infrared cameras are fragile and VERY expensive! Handle them
with care...

You will use two microbolometer cameras of different generations. Their
characteristics are given in Table 4.1. Remember that the NETD (noise equiva-
lent temperature difference) is the smallest temperature difference detectable
by the camera (assuming it observes a blackbody). It is often called "thermal
sensitivity" by manufacturers, or "thermal resolution" (by abuse of language).

www.ulis-ir.com
www.ulis-ir.com
http://www.laserfocusworld.com
http://www.laserfocusworld.com
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Camera AGEMA 570 Camera FLIR A655sc
Technology microbolometer microbolometer

Spectral band 8− 14 µm 8− 14 µm
Format 320× 240 pixels 640× 480 pixels
Pitch 50 µm 17 µm

Focal length 40 mm 24.6 mm
f-number 1 1

NETD @30 ◦C < 150 mK < 30 mK
Field of view (FOV) 24◦ × 18◦ 25◦ × 19◦

Frame rate 2.7 Hz 50 Hz full frame

Table 4.1: Characteristics of the two cameras.

P1 Recall the working principle of a microbolometer focal plane array.

P2 Justify the choice of using the W as the flux unit in this lab (as opposed
to s−1 or lumens).

3 Reminders on the physics of an infrared scene

In general, the spectral luminance of any object X at temperature T is given by:[
dL

dλ

]T
X

(λ) = ε (λ) ·
[
dL

dλ

]T
BB

+
ρ (λ)

π
· dE
dλ

(λ) , (4.1)

where
[
dL

dλ

]T
X

is expressed in W ·m−2 · sr−1 ·m−1 (radiant units),

ε (λ) is the emissivity of the object, which depends a priori on the wavelength,
on the temperature of the object, on the surface roughness, etc,[
dL

dλ

]T
BB

is the spectral luminance of a blackbody at the same temperature,

ρ (λ) is the diffuse reflection factor (also called albedo) of the object,
dE

dλ
is the spectral irradiance received by the object X coming from the envi-

ronment.
This expression gives rise to two terms: the first one is the object’s own

luminance, proportional to that which would be emitted by a blackbody at the
same temperature, the proportionality factor being the emissivity (ability of a
material to radiate). This term is often referred to as an emissive contribution.
The second term represents the diffuse reflection of ambient illumination, and
is called the reflective contribution.
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Materials with low
emissivity (poor black-
bodies)

Materials with medium
emissivity

Materials with high
emissivity (excellent
blackbodies)

Polished gold: 0.01-0.1 Rusty aluminium: 0.2-
0.4

Paint: 0.9-0.95

Polished sheet of metal:
0.01-0.05

Rusty sheet of metal:
0.3-0.5

Wood: 0.9-0.95

Polished aluminium:
0.04

Basalt: 0.7 Brick: 0.93

Chrome: 0.1 Concrete: 0.95
Cloth: 0.95
Paper (any color): 0.95
Human skin: 0.95-0.98

Table 4.2: Emissivity values in the 8− 14 µm spectral band.
Sources : Wikipedia.org, Raytek.fr, Woehler.com, Op-
tris.fr.

In the visible domain, the first term is negligible, and we find in the second
term Lambert’s law seen during the photometry course. In the infrared domain,
we often tend to think that the first term is always dominant: we will see that
this is not always the case.

It is interesting to note that at a given wavelength we always have: ε +
ρ + τ = 1 (energy conservation, with τ the transmission factor of the object
under consideration, and using the fact that the absorptivity α is equal to the
emissivity ε second law of Kirchhoff)). Assuming that τ = 0 (opaque material),
we have: ε = 1 − ρ. In addition, if we make the hypothesis that emissivity is
independent of the wavelength in the spectral band of interest (8− 14 µm in
our case), we can rewrite 4.1 under the form:

LTX = ε ·LTBB +
1− ε
π
·E, (4.2)

where LTX , LTBB andE E are now integrated radiometric quantities in the 8− 14 µm
spectral band. This new formulation shows a "communicating vase" effect be-
tween the emissive and reflective contribution.

As an indication, Table 4.2 summarizes some emissivity values in the 8− 14 µmspectral
band.

4 Getting started with the cameras

Each camera is connected to a computer equipped with suitable software: lap-
top + ThermaCam software for the AGEMA camera, and fixed station + Re-
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searchIR software for the FLIR camera. A simplified manual of both softwares
is available in the room.

 Image the same area of the room with both cameras. Adjust the focus and
choose a grey color scale for both cameras.

Q1 Compare qualitatively the images obtained (think in particular of observ-
ing how homogeneous areas of the scene are reproduced).

 Present the available samples in front of the infrared camera: golden mir-
ror, germanium window, ZnSe window, plastic cover, plexiglass plate, trash
bag. Also observe a face (if possible with glasses) and the bulb of the desk
lamp (lit, then turned off).

 Save a few images showing:

• That a transparent material in the visible can be opaque in the infrared.

• that an opaque material in the visible can be transparent in the infrared.

• a thermal imprint, i.e. the trace left in the infrared by a hot element
placed a few seconds on a cold element (or vice versa)

• an infrared reflection phenomenon

Q2 Comment on these images.

 Measure the temperature of the palm of your hand.

Q3 Comment on the value obtained.

5 Influence of emissivity

In this part, only the FLIR camera is used.
There is a copper plate with two different surface treatments: left, matt

black paint, and right, sandblasting. This plate is temperature controlled by a
thermoelectric module.

 Adjust the temperature of the copper plate to about 40 ◦C using the cali-
bration chart available in the room. Image the copper plate by placing the FLIR
A655sc camera at a distance of about 1m. Select two measuring zones in the
left and right half of the copper plate respectively. Record the temperature for
each measurement area and the raw signal.
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Q4 Using the concept of emissivity, explain the observed temperature differ-
ence.

 Set the plate temperature to approximately 20 ◦C.

Q5 Why is there an inversion of contrast compared to the previous measure-
ment?

 Measure again the temperatures displayed for each part of the plate.

Q6 Using equation (4.2), show that it is possible to estimate emissivity with
the following formula:

ε =
L40 ◦C

right − L20 ◦C
right

L40 ◦C
left − L20 ◦C

left

(4.3)

Q7 Deduce the emissivity value of sandblasted copper from your measure-
ments.

Another method - empirical - to determine the emissivity of the sandblasted
part is to modify the emissivity of this zone in the software so as to obtain the
same temperature as the left part with an emissivity of 1.

 Set the copper plate temperature to approximately 30 ◦C. Using this method,
determine a second measurement of the emissivity of sandblasted copper.

Q8 Compare with the first measurement. Which experimental parameter
must be entered to correctly measure emissivity with this second method?

Q9 Based on the measurements in this section, what advice would you give
to someone who wants to measure the temperature of metal elements?

6 Measuring the performance of infrared cameras

6.1 NETD measurements

The noise equivalent temperature difference (or NETD for Noise Equivalent
Temperature Difference) indicates the thermal sensitivity of a camera, i.e. its
ability to distinguish small temperature variations.

Suppose a camera observes a blackbody large enough to cover several pix-
els (see figure 4.2). By definition, the NETD of the infrared camera is the
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blackbody temperature difference that results in a signal variation equal to the
standard deviation σs (rms) of the noise:

∆T = NETD si |Vi,j(T + ∆T )− Vi,j(T )| = σs (4.4)

Figure 4.2: Illustration of the concept of NETD.

The NETD depends on the noise of the detector (NEP: Noise Equivalent
Power, or flux equivalent au bruit in French) but also on the characteristics
of the optics (in particular transmission and aperture number). The NETD is
therefore a figure of merit of the camera as a whole (optics + detector).

 Adjust the temperature of the blackbody to 30 ◦C by taking care to wait
until it stabilizes. Define a temperature measurement point and a wide area
covering about half the surface of the blackbody.

 Record the temperature evolution measured in both zones over a period
of 1 minute. Export the data to Excel.

Q10 Measure the standard deviation, and therefore the NETD, on the signal
coming from the pixel alone. Do the values found correspond to the perfor-
mance figures announced by the manufacturers? Why ?

In an imaging system, it is common to improve the signal-to-noise ratio using
spatial averaging. Measure the standard deviation on the signal coming from
the wide area, and therefore the new thermal sensitivity, always for a duration
of 1 minute.
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Q11 Shouldn’t we see a greater improvement in the sensitivity? Suggest an
explanation.

Q12 Why does the manufacturer announce a NETD value “ at 30 ◦C ” ?

6.2 MRTD measurements

As noted above, the NETD quantifies only the camera’s thermal sensitivity,
without taking into account any limitations related to camera resolution. How-
ever, the scene observed by the camera may include high spatial frequencies
(fine details), potentially poorly reproduced by the optics (if the fine details
are smaller than the Airy spot) or by the detector array (if the fine details are
smaller than the pixel size). This is where the MRTD (Minimum Resolvable
Temperature Difference) comes in. It is measured by means of a differential
blackbody equipped with a pattern of standardized shape, made up of 7 bars
(or 3 cycles and a half) alternately cold and hot. The MRTD measurement
is done by observing the disappearance of the bars of the test pattern in the
image when the temperature difference becomes too small. The MRTD thus
takes into account the scene (space-frequency composition), the monitor and
the observer: it is a parameter representative of the complete optronic chain
(and not just of the camera).

Figure 4.3: Principle of the MRTD measurement.

 Position the pattern with a period p = 2.55 mmin front of the blackbody.
Set the temperature of the blackbody to 1 ◦CC above the target temperature
(which is indicated on the blackbody controller, upper dial). Set the FLIR cam-
era 1m from the test pattern and adjust the focus. Release the temperature
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setpoint by turning the charge/repos switch of the blackbody to repos: the
blackbody temperature will slowly return to room temperature. Observe the
image of the test pattern and note the temperature of the blackbody when the
test pattern disappears: the MRTD is the difference between this temperature
and the temperature of the test pattern.

 Repeat the measurement for a distance blackbody - camera of 1, 30 m, then
1, 50 m (in this last case, the temperature of the black body will be adjusted
2 ◦Cabove that of the test pattern before releasing the set point).

Q13 Record the results on a graph.

It is recalled that the spatial frequency (in object space) is given by: ν = D/p,
where D is the black body - camera distance, and where p is the period of the
target. If D is expressed in m and p in mm, ν is in cycles/mrad.

 Measure the AGEMA camera MRTD for D=0.5m, 0.65m, 0.75m and 1m.
Set the blackbody temperature to 1 ◦C, 2 ◦C, 4 ◦C and 5 ◦C above the target
temperature, respectively.

Q14 Plot the results obtained on the previous graph. How to interpret the
observed differences between the two cameras?

After characterizing the FLIR camera (measurements of NETD and MRTD),
we propose to use it to discover two applications of infrared imaging: infrared
thermography and non-destructive testing.

7 Absolute temperature measurement

Some applications of infrared thermography seek to detect local heating (e. g.
thermal leak detection in buildings or predictive maintenance of electrical in-
stallations). In this case, the NETD (or MRTD) are well suited figures of merit
for estimating the performance of an infrared camera. In other applications,
the absolute temperature of an object (e. g. for monitoring damage to mechan-
ical parts in the aeronautical industry, or for monitoring the proper functioning
of a nuclear fusion reactor) can be measured precisely. We are now interested
in this type of applications, which require more performance. In this section,
we try to estimate the accuracy with which the FLIR camera can perform an
absolute temperature measurement.

Set the temperature of the blackbody to 60 ◦C. Position the camera 60cm
from the blackbody, and place a temperature measuring point in the middle
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of the blackbody (do not forget to indicate the emissivity and the reflected
temperature !). Wait for the blackbody temperature to stabilize.

Q15 Knowing that the focal length of the lens is 24 mm and the pixel pitch
is 17 µm, what is the field of view of one pixel? What surface does this field
correspond to at the level of the blackbody?

 Insert the iris diaphragm between the blackbody and the camera (a few
centimeters from the blackbody) and center it in relation to the temperature
measurement point. Focus on the diaphragm. Perform a series of 4-5 tem-
perature measurements for a diaphragm diameter ranging from 4 mm to full
aperture.

Q16 Does the measured temperature vary according to the size of the di-
aphragm? Is this the expected result?

Q17 Compare any temperature variations observed with the previously mea-
sured NETD. Does NETD represent the accuracy with which it is hoped that an
absolute temperature measurement can be achieved with this camera?

8 Non destructive testing (NDT)

In this section, we are interested in a particular application of infrared: non-
destructive testing (NDT), which aims to highlight the presence of defects in
the material by remote and non-contact measurement. Infrared imaging is thus
used to detect defects in all kinds of materials, from composite materials used
in aeronautics to agri-food products.

The principle of measurement is as follows: the surface of a sample is ther-
mally excited and its surface temperature changes as a function of time. It is
possible to show defects in the volume of the material.

Industrial NDT systems offer flash or halogen lighting, and the sensitivity
of the sample to excitation can be observed in reflection (measurement on the
front side) or transmission (measurement on the backside). In the framework
of this lab, lighting is done with 400W halogen lamps and observation on the
front side.
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Figure 4.4: Experimental configuration used in this lab : excita-
tion with halogen lamps, and front side observation.

 Position the two small frames in front of the camera (be careful with the
thermal imprints you will leave when touching the objects!).

 Take a first infrared image of the two frames before lighting them. Turn
on the halogen lamps for 10-15s and take a second image.

Q18 What are you observing? What do you deduce from this on the internal
structure of the two objects?

 Now place the cardboard-covered sample (the cardboard side towards the
camera) in front of the camera.

 Illuminate the sample for one minute and record the resulting infrared
image.

Q19 Comment on it.

 Turn the sample over and illuminate the other side again for one minute.

Q20 What are you observing?
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Annexe 1: Blackbody law

We recall for the record the law of the black body (Planck’s law) seen during
radiometry course:

[
dLe
dλ

]T
BB

=
2hc2

λ5

1

e
hc

λkBT − 1
(4.5)

where
[
dLe
dλ

]T
BB is expressed in W ·m−2 · sr−1 ·m−1, T is the blackbody tem-

perature in K, λ l is the wavelength in m, c = 3× 108 m/s, h = 6, 63× 10−34 J · s
(Planck’s constant) , and kB = 1, 38× 10−23 J/K (Boltzmann’s constant). As
an example, we can compare this spectral luminance for various temperatures
between 295 K and 315 K, i.e. 22◦C and 42◦C

Figure 4.5: Spectral luminance of a black body (in
W ·m−2 · sr−1 ·µm−1

) as a function of wavelength,
for various temperatures.

We see that the flux emitted from a black body increases with its temper-
ature. The camera’s bolometer is a thermal detector : it is sensitive to the
incident power. Its sensitivity can be supposed constant on the IR band III (8-
14 µm). The transmission of the lens can as well be considered as constant over
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this band. With those hypothesis, the video signal obtained from the image of
a black body of temperature T is :

v(T ) = K.

∫ 14µm

8µm

dL

dλ
(λ, T ) dλ

The following curve shows the result of the computation of this integral for
a temperature varying between 275 K and 325 K (approximately 0◦C to 50◦C)
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Figure 4.6: Total illuminance of the source, on the 8-12 µm band,
as a function of its temperature.

We see that the hypothesis of a linear variation of the video signal with
regard to the temperature is not realised. However, the error remains small on
this limited temperature range of 20 to 40 ◦C.

Annexe 2 : MRTD measurement

We can show that the MRTD reads:

MRTD(ν) = K
NETD

FTMglobal(ν)
, (4.6)

where K is a constant and where the overall MTF of the camera is the product
of the optical and detector transfer functions by a S(ν) function that accounts
for the spatial response of the monitor and the eye (in all honesty, it is difficult
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to define a transfer function for the eye because it is non-linear):

FTMglobal(ν) = FTopt(ν) ·FTdet(ν) ·S(ν) (4.7)

In the rest of this annexe, the S(ν)function will be ignored.
It is recalled that the transfer function of an optics limited by diffraction

(without aberrations or errors of realization, with a circular pupil) is given by:

FTopt(ν) =
2

π

arccos

(
ν

νc,opt

)
− ν

νc,opt

√
1−

(
ν

νc,opt

)2
 , (4.8)

where ν is the spatial frequency (in image space) and νc,opt is the cutoff fre-
quency of the optics (also in image space), given by: νc,opt = 1

λN .
In the hypothesis of a square pixel of a given pixel size, the detector MTF is

given by:

FTdet(ν) =

sin

(
π

ν

νc,det

)
π

ν

νc,det

, (4.9)

where νc,det is the cutoff frequency of the detector (in image space): νc,det =
1

pixel size .
For the FLIR camera, the optics and detector modulation transfer functions

are plotted in 4.7, along with the MRTD curve. This one grows with the spatial
frequency, until reaching a vertical asymptote corresponding to the detector’s
cut-off frequency: this being lower than the optic’s cut-off frequency, it is there-
fore the pixel size that limits the camera’s resolution.
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Figure 4.7: Upper panel : MTF of optics and detector, for the
FLIR camera ; lower panel : MRTD of the FLIR cam-
era. The vertical asymptote corresponds to the cutoff
frequency of the detector.
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